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ÖNSÖZ 
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indirebilmek için yıkılma analizlerinin yapılması ve önceden gerekli tedbirlerin alınması gerekmektedir. 
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analizi yapılmış ve baraj yıkılması sonucu oluşacak taşkınların risk haritaları, oluşma zamanları ve su 

yükseklikleri ile ilgili bilgiler elde edilmiştir. Bu çalışma sonucunda elde edilen risk haritaları, erken uyarı 
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ÖZET 

Baraj Yıkılması Taşkın Risk Analizi Yeşildere Barajı Örneği 

Can YILDIZ  

Yüksek Lisans Tezi 

FIRAT ÜNİVERSİTESİ 
Fen Bilimleri Enstitüsü 

 
İnşaat Mühendisliği Anabilim Dalı 

Mart 2021, Sayfa x+56 

Güvenli yapılar olarak bilinen ve birçok amaca hizmet eden barajlar aşırı yağış, yapısal hatalar ve 

deprem gibi nedenlerden dolayı yıkılabilirler. Yıkılmaları sonucunda oluşacak taşkın dalgaları büyük 

felaketlere yol açacaktır. Baraj yıkılması sonucu oluşabilecek taşkınların modellenmesiyle meydana 

gelebilecek zararlar en aza indirilebilir. Bu tez çalışmasında; Bursa İli Karacabey İlçesinde yapım çalışmaları 

devam eden ve mansabında yerleşim yeri bulunan Yeşildere Barajı’nın iki boyutlu yıkılma analizleri 

gerçekleştirilmiştir. Çalışmanın amacı, baraj yıkılması durumunda oluşan taşkının mansapta yer alan 

yerleşim yerine ulaşıp ulaşamayacağı ve ulaşma zamanının belirlenmesidir. Yeşildere Barajı ve mansap 

bölgesine ait sayısal haritalar ArcGIS yazılımı ile düzenlenmiş ve yıkılma analizi USACE tarafından 

geliştirilen HEC-RAS programı tarafından yapılmıştır. Yapılan analiz sonucunda mansap bölgesinde bazı 

yerleşim bölgelerinin taşkından etkilendiği tespit edilmiş ve taşkın risk haritaları oluşturularak maksimum su 

seviyeleri ve bu seviyelerin oluşma zamanları belirlenmiştir.     

Anahtar Kelimeler: Baraj Yıkılması, Taşkın, HEC-RAS, 2B Modelleme, Yeşildere Barajı 
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ABSTRACT 

Dam Break Flood Risk Analysis; An Example of Yeşildere Dam 

 
Can YILDIZ 

 
Master's Thesis 

 
FIRAT UNIVERSITY 

Graduate School of Natural and Applied Sciences 

 

Department of Civil Engineering 
March 2021,   Pages:  x+56 

The dams, known as safe structures and serving many purposes, can be demolished due to excessive 

precipitation, structural errors, and earthquakes. Flood waves that will occur as a result of their demolish will 

lead to great disasters. By modelling the floods that may occur as a result of the demolition of the dam, the 

damages that may occur can be minimized. In this thesis study; Two-dimensional demolition analysis of 

Yeşildere Dam, which is under construction in the Karacabey District of Bursa Province and has a settlement 

in downstream, was carried out. The aim of the study is to determine whether the flood that occurs in the 

event of the demolition of the dam will reach the settlement downstream, and the time to reach its. Numerical 

maps of the Yeşildere Dam and downstream region were edited by ArcGIS software and the collapse analysis 

was done by the HEC-RAS program developed by USACE. As a result of the analysis, it was determined 

that some settlements in the downstream area were affected by the flood, and by creating flood risk maps, 

the maximum water levels, and the timing of these levels were determined. 

Keywords: Dam Break, Flood, HEC-RAS, 2D Modelling, Yeşildere Dam 
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1. GİRİŞ 

Akarsular üzerine inşa edilen barajlar, içme suyu temini, tarımsal sulama, taşkın kontrolü 

sağlamak, endüstri suyu temini, elektrik üretimi, rekreasyon aktiviteleri, katı madde hareketinin 

kontrolü ve balıkçılık faaliyetleri gibi farklı amaçlara yönelik inşa edilmektedir. Barajlar hizmet 

ettikleri amaçlar doğrultusunda ülkelerin ve toplumların gelişmesine ciddi derecede katkı 

sağlayarak uygarlık seviyelerini yükseltmektedir. Gelişmiş ülkeler hemen hemen ihtiyaç 

duydukları barajları tamamlamışken, gelişmekte olan ve az gelişmiş ülkeler ise baraj sayılarını 

arttırmaya çalışmaktadır (Karakaya, 2005).  

Ülke ekonomisine kattıkları katma değerlerle önemli yere sahip olan barajlar aynı zamanda 

rezervuarlarında bulundurdukları büyük miktarlardaki su potansiyellerinden dolayı risk 

taşımaktadır. Olası bir baraj yıkılması, özellikle mansap bölgesinde yerleşim yerleri bulunması 

halinde önemli can ve mal kayıplarına neden olacaktır (Palamut, 2014). 

Güvenli yapılar olan barajların önde gelen yıkılma nedenleri; temellerindeki hatalar, 

rezervuarlarında meydana gelen taşkın dalgalarının gövde üzerinde aşmaları ve baraj gövdesinde 

borulanma olarak sıralanabilir (Paknıyat, 2015). 

Tamamen baraj yıkılma olaylarını önlemenin imkansız olmasından dolayı oluşabilecek 

yıkılmaların etkilerini en aza indirebilecek tedbirlerin alınması gerekmektedir. Bunun için uzman 

kişiler tarafından gözlemlerin yapılması, deneysel ve teorik uygulamalarla oluşturulacak 

modellemeler ile oluşacak taşkın dalgalarının yükseklikleri, yayılma alanları, risk haritaları ve 

taşkının süreleri gibi veriler elde edilerek acil durum planları hazırlanmalıdır (Kocaman S. , 2002). 

Günümüzde teknolojinin ilerlemesi ile 2 ve 3 boyutlu sayısal modelleme yapabilen paket 

programlar geliştirilmiştir. FLO-2D, HEC-RAS 5, MIKE21 ve SOBEK gibi 2 boyutlu analiz 

yapabilen paket programlar ile baraj yıkılması sonucu oluşacak taşkın yayılım haritaları 

oluşturularak taşkın simülasyonları yapılabilmektedir. Ayrıca 3 boyutlu ve daha hassas sonuçlar 

verebilen FLOW-3D gibi paket programlar yardımıyla da taşkın analizleri yapılarak simülasyonlar 

oluşturulmaktadır (Paknıyat, 2015). 

Ülkemizde barajların olası yıkılmaları sonucu oluşabilecek taşkın tehlike boyutlarının 

belirlenmesi ve risk haritalarının oluşturulması amaçlı sayısal analizler ve çalışmalarda artışlar 

gözükmekte olup konu ile ilgili kurumlarla bilgi paylaşımı yapıldığı görülmektedir (Bozkuş & 

Güner, 2001). 

Bu çalışmanın amacı; Marmara Bölgesinde bulunan Bursa İl’inin Karacabey İlçesinde 

bulunan Yeşildere Barajı’nın aşırı yağışlardan, barajın yapısal problemlerinden veya deprem gibi 

nedenlerden dolayı oluşabilecek baraj yıkılmasının 2 boyutlu analizini yaparak, mansabında 

taşkının yayılım haritalarının ve risk haritalarının oluşturulup, maksimum su seviyelerinin ve 

oluşma zamanlarının belirlenmesidir. Yeşildere Barajı’nın mansap bölgesinde yerleşim yerlerinin 
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bulunması ve daha önceden de herhangi bir taşkın riskine karşılık çalışma yapılmamasından dolayı 

taşkın risk haritalarının oluşturulması ile taşkının yerleşim yerine varış süresinin tespit edilmesi 

önem arz etmektedir. Bu tür yaşanan afetlerde insanların o bölgeyi tahliye etme süreleri oldukça 

kısa olup önceden belirlenen güvenli yerlere gitmeleri gerekmektedir. Yeşildere Barajı’nın yıkılma 

analizi yapılarak elde edilecek risk haritaları, yerleşim yerindeki insanların erkenden uyarılarak 

zamanında güvenli yerlere tahliyelerinin gerçekleştirilmesi açısından önemli bilgileri 

barındıracaktır. Yeşildere Barajı’nın mansap bölgesinde, Yeşildere Mahallesi’nin bulunması ve 

baraja ortalama 1 km uzaklıkta olmasından dolayı; olası bir baraj yıkılması durumunda risk altında 

olacak ve kısa sürede taşkın dalgalarına maruz kalacaktır. 

Baraj yıkılma analizleri ile ilgili önceden yapılmış olan çalışmalar hakkında yapılan literatür 

araştırmaları aşağıda yer almaktadır. 

Kocaman (2002), çalışmasında barajların su temininde, taşkın kontrolünde, enerji üretiminde 

ve rekreasyon gibi pek çok amaç için kullanıldığını ve güvenli su yapıları olmalarına rağmen 

geçmişte yaşanan baraj yıkılma felaketlerinden dolayı her barajın yıkılma riskine sahip olduğunu 

belirtmiştir. Barajların yıkılma risklerinin bulunmasından dolayı mansap bölgesinde yıkılmadan 

dolayı oluşan taşkınların can ve mal kayıplarına neden olacağı belirtilmiştir. Çalışmasında Adana 

İli Kozan İlçesinde bulunan ve mansap bölgesinde ilçe merkezinin bulunduğu Kozan Barajı’nın 

yıkılma analizi yapılmıştır. Baraj yıkılma analizinde National Weather Service (Ulusal Hava 

Servisi) tarafından geliştirilen NWS FLDWAV programı kullanılmıştır. Çalışmada yıkılma 

parametrelerinin taşkın dalgalarının büyüklüğünü ve sürelerini etkilediği ayrıca mansap bölgesinin 

pürüzlülük değerlerinin de taşkın hızlarını ve yüksekliklerini etkilediğini tespit etmiştir (Kocaman 

S. , 2002). 

Bayraktar (2004), çalışmasında baraj yıkılma sonucu oluşan taşkın dalgalarının Coğrafi Bilgi 

Sistemleri (CBS) kullanılarak daha sağlıklı haritaların oluşturulacağı belirtilerek CBS yardımıyla 

risk haritalarının oluşturulması incelenmiştir. Çalışmada Alibeyköy Barajı’nın yıkılma analizi CBS 

yardımıyla oluşturulan sayısal yükseklik haritalarının OPEN GL ve DELPHI programları 

kullanılarak 3 boyutlu model haline dönüştürülerek yapılmıştır. Çalışma sonucunda CBS ve 

uzaktan algılama sistemlerinin taşkın risk haritalarının oluşturulmasında başarılı bir şekilde 

kullanıldığı tespit edilerek ülkemizde bulunan bütün barajlar için erken uyarı sistemlerinin 

kurulması tavsiye edilmiştir (Bayraktar, 2004).  

Karakaya (2005), çalışmasında Bartın İli sınırlarında ve Gökırmak nehri üzerinde bulunan 

Kirazlıköprü Barajı’nın farklı hidrolik senaryolar altında baraj yıkılma analizlerini yaparak baraj 

mansabında meydana gelebilecek olumsuz durumlar tespit edilmiştir. Çalışmasında National 

Weather Service (Ulusal Hava Servisi) tarafından geliştirilen NWS FLDWAV programı 

kullanılmıştır. FLDWAV programında farklı baraj yıkılma parametreleri kullanılarak sonuçları 

karşılaştırılmıştır. Kirazlıköprü Barajı’nın yıkılma senaryoları sonucunda mansap bölgesinde yer 
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alan yerleşim yerlerinin taşkına maruz kaldığı tespit edilmiştir. Elde edilen sonuçlar doğrultusunda 

acil durum planlarının yapılabileceği ve erken uyarı sistemleri kurularak olası can ve mal 

kayıplarının aza indirilebileceği belirtilmiştir (Karakaya, 2005). 

Özdemir vd. (2011), çalışmasında insan kaynaklı olarak inşa edilen baraj gibi büyük su 

yapılarının yıkılması durumunda oluşacak taşkınların doğa kaynaklı olan taşkınlardan daha fazla 

yıkıcı etkilere neden olduğunu belirterek bu yapıların çökmesi halinde oluşacak taşkınları 

incelemiştir. Çalışmasında Çanakkale İlinde bulunan Çokal Barajı’nın menba batardosunun 16 

Kasım 2007 yılında meydana gelen aşırı yağışlardan dolayı çöktüğünü ve 12,30 hm3’lük suyun 

Kavak-Evreşe ovasına akıp tarım alanlarına zarar verdiğini belirterek olası baraj gövde çökmesi 

analizini HEC-RAS (Hydrologic Engineering Centers River Analysis System) programı ile yaparak 

oluşacak tehlikeleri incelemeyi amaçlamıştır. Çalışma sonucunda 2007 yılında meydana gelen 

memba batardosunun yıkılması sonucu oluşan taşkın alanının HEC-RAS programı sonuçlarıyla 

yakın olduğu görülmüştür. Ayrıca baraj gövdesinin yıkılması durumunda taşkın yayılım haritası 

oluşturularak baraj mansabında bulunan Kavak Beldesine taşkının 3 saat 12 dakika sonra ulaşacağı 

belirtilerek yerleşim yerinde bulunan insanların tahliyesi için yeterli bir süre olduğu tespit edilmiştir 

(Özdemir, Akbulak, & Özcan, 2011). 

Palamut (2014), çalışmasında baraj mansap bölgesinde yerleşim yerlerinin bulunması 

durumunda oluşacak bir baraj yıkılması anında tehlikelerin boyutunu saptamanın önemli olduğunu 

belirtmiştir. Çalışmasında İzmir İli Ödemiş İlçesinde bulunan ve mansap bölgesinde yerleşim yeri 

bulunan Rahmanlar Barajı’nın bir ve üç boyutlu yıkılma analizleri gerçekleştirilmiştir. Baraj 

mansabında bulunan yerleşim yerlerinin taşkından etkilenip etkilenmediğinin tespiti amaçlanmıştır. 

Bir boyutlu analizler için HEC-RAS (Hydrologic Engineering Centers River Analysis System) 

programı üç boyutlu analizler için ise hesaplamalı akışkanlar dinamiği programı olan FLOW-3D 

kullanılmıştır. HEC-RAS programı ile yapılan bir boyutlu baraj yıkılması analizlerinde yerleşim 

yerlerinin etkilendiği belirtilmiştir. Fakat akımların doğrusal olarak ilerlediği mantığıyla çalışan 

HEC-RAS programı sonucunda elde edilen verilerin daha doğru olabilmesi için arazi ve akımları 

daha sağlıklı tanımlayabilecek olan üç boyutlu yıkılma analizinin yapılması gerektiğine ulaşmıştır. 

Üç boyutlu analiz için FLOW-3D yazılı kullanılarak yıkılma senaryoları elde edilmiştir. Her iki 

programdan elde edilen analizler sonucunda taşkın haritaları, maksimum su seviyeleri ve taşkının 

yerleşim yerlerine ulaşma süreleri belirlenerek karşılaştırılmıştır. Karşılaştırılan verilerin hemen 

hemen birbirine yakın olduğunu tespit etmiştir (Palamut, 2014). 

Paknıyat (2015), çalışmasında barajların güvenli yapılar olduğunu belirtmiş ancak 

biriktirdikleri su hacimlerinden dolayı ve gövdeden su aşması, yetersiz dolusavak tasarımı ve baraj 

gövdesinde meydana gelecek oturmalardan dolayı yıkılma risklerinin bulunduğunu belirtmiştir. 

Çalışmada İzmir İli Gümüldür İlçesinde bulunan Tahtalı Barajı’nın tamamen yıkıldığı ve 

gövdesinin %50 oranında yıkıldığı varsayılarak analizler FLOW 3D programı ile yapılarak taşkın 
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derinliği ve hız değerleri incelenmiştir. Çalışma sonucunda elde edilen haritalar doğrultusunda 

taşkın dalgalarının zararlarını azaltmak doğrultusunda baraj mansap bölgelerinde bent inşa edilmesi 

tavsiye edilerek yerleşim yerlerinde bulunan insanların zaman kazanmasına yardımcı olacağı 

belirtilmiştir. Baraj mansap bölgelerinde inşa edilecek bentler ve engeller ile taşkın dalgalarının su 

seviyelerinin ve hızlarının azalacağı tespit edilmiştir (Paknıyat, 2015). 

Dal (2018), çalışmasında eğimli kanalda deneysel ve nümerik olarak ardışık iki barajın 

yıkılması incelenmiştir. Nümerik analizlerde FLOW-3D ve DualSPHysics programları 

kullanılmıştır. Deneysel veriler ise ultrasonik sensörler ve görüntü işleme tekniği ile elde edilmiştir. 

Çalışmada deneysel ve nümerik sonuçlar karşılaştırılmış ve genel olarak birbirleri ile uyumlu 

olduğu tespit edilmiştir (Dal, 2018). 

Ergen (2019), çalışmasında birçok amaca hizmet eden barajların yıkılmaları halinde 

oluşacak taşkın dalgalarının can ve mal kayıplarına neden olacağı belirtilmiştir. Çalışmada Sakarya 

İli Geyve İlçesinde bulunan Doğantepe Göleti’nin yıkılma analizi HEC-RAS programı kullanılarak 

yapılmıştır. Çalışma sonucunda gölet yıkılmasından dolayı oluşacak taşkının mansapta bulunan 

Geyve ilçesini etkileyeceği ve taşkın yayılım haritaları oluşturularak maksimum su yüksekliği ve 

taşkın dalgalarının oluşma süreleri tespit edilmiştir (Ergen, 2019).   

Kocaman (2019), çalışmasında baraj yıkılması sonucu oluşacak sel dalgalarının tehlike 

boyutlarını incelenmiştir. Çalışmada Kahramanmaraş İlinde bulunan Kartalkaya Barajı’nın yıkılma 

analizleri HEC-RAS ve FLO-2D yazılımları kullanılarak oluşturulmuş ve elde edilen sonuçlar 

karşılaştırılmıştır. Programlarda kullanılan pürüzlülük değerleri Avrupa Çevre Ajansı tarafından 

oluşturulan CORINE (Çevresel Bilgi Koordinasyonu) haritalarından yararlanılarak seçilmiş ve 

farklı pürüzlülük değerlerinin program çıktılarına etkileri de gözlenmiştir. Çalışma sonucunda iki 

farklı program tarafından elde edilen taşkın derinlikleri ve hız haritaları ile pürüzlülük değerlerinin 

arttığında akımın hızının azaldığı, akımın derinliğinin ise arttığı tespit edilmiştir (Kocaman B. , 

2019). 

Alppay (2019), çalışmasında baraj yıkılmaları sonucunda oluşacak taşkın tehditlerinin aza 

indirilmesi için baraj yıkılma analizlerinin yapılması gerektiğini belirtmiştir. Çalışmada Kocaeli 

İlçesinde bulunan Kirazdere (Yuvacık) Barajı’nın muhtemel yıkılması sonucu oluşacak riskli 

bölgelerin belirlenmesi amaçlanmıştır. HEC-RAS programı aracılığıyla baraj yıkılma parametreleri 

veri girişi yapılarak yıkılma analizi yapılmıştır. Baraj yıkılma taşkını (BYT) analizi sonuçlarında 

yayılım haritaları elde edilerek maksimum derinlik, hız ve su taşkın haritaları elde edilerek mansap 

bölgesindeki riskli alanlar tespit edilmiştir (Alppay, 2019). 

Şen (2019), çalışmasında Atatürk Barajı’nda olası bir hasar görmesinden dolayı yıkılma 

sonucu oluşacak taşkın dalgaları incelenmiştir. Çalışmada HEC-RAS programı kullanılarak 

program için gerekli olan sayısal altlıklar ArcGIS programı tarafından üretilmiştir. Çalışma 

sonucunda baraj yıkılması ile oluşacak taşkın sularının derinlik ve hız değerleri oluşturularak taşkın 
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haritaları oluşturulmuştur. Ayrıca taşkın sularının 24 saatten kısa bir sürede Birecik Barajına 

ulaşabileceği ve ikinci bir baraj yıkılma durumunun oluşabileceği tespit edilmiştir (Şen, 2019). 

Aajamı (2019), çalışmasında toprak dolgu barajların gövdelerinde oluşacak çatlak ve 

borulanmadan dolayı oluşacak baraj yıkılması modellenmiştir. Çalışmada İzmir İli Menemen 

İlçesinde bulunan Süleymanlı Barajı incelenerek yıkılma analizi gerçekleştirilmiştir. Uygulamada 

Plaxis 2D ve FLOW 3D programları kullanılmıştır. Baraj gövdesinde oluşacak çatlak ve borulanma 

modellemesi Plaxis 2D programıyla modellenmiş ve gövde kret kotu su kotu altına düştüğü andaki 

veriler FLOW 3D programına aktarılarak baraj gövdesinden aşan suyun barajı yıkması ile oluşan 

taşkın dalgaları incelenmiştir. Çalışma sonucunda gövdede meydana gelen deformasyonların kil 

çekirdeğinin orta ve aşağı kısımlarında meydana geldiğini ve çatlak doğrultularının aşağıya doğru 

olduğunu tespit etmiştir (Aajamı, 2019). 

Bu çalışma için Yeşildere Barajı ile ilgili bilgiler DSİ (Devlet Su İşleri Genel Müdürlüğü) 1. 

Bölge Müdürlüğünden ve çalışma alanına ait sayısal haritalar Bursa Su ve Kanalizasyon Genel 

Müdürlüğünden (BUSKİ) temin edilmiştir. Temin edilen veriler ve bilgiler doğrultusunda çalışma 

alanının sayısal yükseklik haritaları ArcGIS programıyla oluşturularak yıkılma analizini yapacak 

programa aktarılmıştır. Yeşildere Barajı’nda meydana gelecek yıkılma sonucunda oluşacak 

taşkının 2 boyutlu analizi Amerika Birleşik Devletleri Ordusu tarafından geliştirilen HEC-RAS 

programı ile incelenip taşkın riski taşıyan alanlar tespit edilerek, taşkın dalgalarının maksimum 

yükseklikleri, taşkının yerleşim yerine varış süresi ve taşkın risk haritaları oluşturulmuştur. Baraj 

yıkılma analizi sonucunda elde edilen taşkın risk haritaları, taşkının yerleşim yerine varış süresi ve 

maksimum su yüksekliği bilgileri doğrultusunda, öncelikle erken uyarı sistemlerinin kurulması ve 

taşkın riski taşıyan bölgelerde bulunan insanların güvenli yerlere tahliye edilmesine yönelik ilgili 

ve görevli kurumlarca acil durum tahliye planları ile afet yönetim ve müdahale planlarının 

hazırlanmasına yardımcı olacaktır.  

 

 



2.  BARAJ YIKILMASI 

Olası bir baraj yıkılması sonucu oluşacak taşkın sonuçlarını görebilmek, olumsuz sonuçları 

önlemek veya en aza indirebilmek, gerekli tedbirleri almak ve eylem planlarını oluşturmak için 

baraj yıkılma analizlerinin yapılması son derece önemlidir. Farklı baraj yıkılma senaryoları 

oluşturularak ortaya çıkacak taşkın debilerinin, su yüzü kotlarının, yayılım alanlarının ve yerleşim 

yerlerine varış sürelerinin tespit edilmesi oluşabilecek can ve mal kayıplarının aza indirilmesine 

yardımcı olacaktır. 

2.1. Dünyadaki Mevcut Barajların Durumu 

Yeryüzünde bulunan suları etkin ve verimli bir şekilde kullanmak amaçlı inşa edilen barajlar; 

büyüklüklerine, kullanım amaçlarına ve tiplerine göre sınıflandırılmaktadır (Şen, 2019).  

ICOLD’a (Uluslararası Büyük Barajlar Komisyonu) göre barajlar büyüklüklerine göre üçe 

ayrılmaktadır. Kreti ile temeli arasında 15 m yüksekliğin olduğu barajlar ile yüksekliği 10-15 m 

arasında olan fakat buna ek olarak; kret uzunluğu 500 m’den uzun olan, rezervuar hacmi 106 m3’ten 

büyük olan veya en büyük taşkın debisi 1000 m3/sn olma özelliklerinden en az birini taşıyan barajlar 

büyük baraj olarak isimlendirilmektedir. Küçük baraj (Gölet)  ise büyük baraj tanımının dışında 

kalan, projesi daha basit olan barajlardır.  Ayrıca; kret ile temeli arasında 50 m den fazla yükseklik 

bulunan barajları da yüksek baraj olarak nitelendirmektedir (ICOLD, 2020). 

ICOLD’a göre barajlar amaçlarına göre de tek ve çok amaçlı olmak üzere ikiye 

ayrılmaktadır. Sadece bir tek amaca yönelik inşa edilen barajlar tek amaçlı baraj olarak 

sınıflandırılmaktadır. Dünyada tek amaçlı baraj olarak inşa edilen baraj sayısı 28 214’dür. Barajlar; 

tarım alanlarının su ihtiyacını karşılanması, enerji üretimi, içme ve kullanma suyu temini, taşkın 

yönetimi, piknik ve turizm gibi amaçlara hizmet için inşa edilmektedirler. Birden fazla amaca 

yönelik inşa edilen barajlar ise çok amaçlı barajlar olarak nitelendirilmektedir. ICOLD verilerine 

göre dünyada 10 207 adet çok amaçlı baraj bulunmaktadır. Şekil 2.1’de dünyadaki tek ve çok 

amaçlı barajların sayıları yer almaktadır (ICOLD, 2020). 
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Şekil 2.1. ICOLD’a göre dünyadaki tek ve çok amaçlı barajlar (ICOLD, 2020) 

 

Şekil 2.2 ve Şekil 2.3‘te tek amaçlı ve çok amaçlı barajların kullanım amaçlarına göre 

dağılımları verilmiştir (ICOLD, 2020). 

 

 

Şekil 2.2. ICOLD’a göre tek amaçlı barajların amaçlarına göre dağılımı (ICOLD, 2020) 
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Şekil 2.3. ICOLD’a göre çok amaçlı barajların amaçlarına göre dağılımı (ICOLD, 2020) 

Barajlar, gövdede kullanılan malzemeye göre; dolgu barajlar ve beton barajlar olmak üzere 

ikiye ayrılmaktadır. 

a) Dolgu Barajlar 

- Toprak dolgu barajlar 

- Kaya dolgu barajlar 

- Ön yüzü betonarme kaplı kaya dolgu barajlar 

b) Beton Barajlar 

- Beton ağırlıklı barajlar 

- Payandalı beton barajlar 

- Beton kemer barajlar 

- Silindirle sıkıştırılmış beton barajlar (SSB) 

olmak üzere alt sınıflara ayrılabilirler (Orhon, 1997). 

Dolgu ve beton barajların dışında genellikle geniş vadilerde bu iki tip barajın gövdede 

birlikte kullanıldığı barajlarda mevcuttur. Bu türden barajlar karma tip baraj olarak 

sınıflandırılmaktadır. Ülkemizde bulunan Keban Barajı bu tip barajlara örnektir (Ergen, 2019). 

Şekil 2.4.’te ICOLD’a göre dünyadaki barajların tiplerine göre dağılımı verilmiştir (ICOLD, 

2020).  
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Şekil 2.4. ICOLD'a göre dünyadaki barajların tiplerine göre dağılımı (ICOLD, 2020) 

2.2. Türkiye’deki Barajların Durumu 

Osmanlı döneminden Cumhuriyet dönemine kadar genellikle içme suyu ihtiyacını 

karşılamak amaçlı bentler yapılmış ve bu bentler özellikle İstanbul çevresinde yoğunlaşmıştır ve 

Tablo 2.1’de Cumhuriyet öncesi ülkemizde inşa edilmiş bentler yer almaktadır (Yiğitbaşıoğlu, 

1996).  

Tablo 2.1. Cumhuriyet öncesi ülkemizde inşa edilen bentler (Yiğitbaşıoğlu, 1996) 

ADI İLİ GÖL HACMİ (m3) YÜKSEKLİĞİ BİTİŞ YILI 

Çavdarhisar Bendi Kütahya - - - 

Örükkaya Bendi Çorum 500 000 - - 

Büget Bendi Niğde - - - 

Löştüğün Bendi Amasya - - - 

Semalı Bendi Amasya - - - 

Topuz Bendi İstanbul 70 000 8,60 620 

Büyük Bent İstanbul 1 318 000 12,15 1724 

Topuzlu Bendi İstanbul 160 000 16,00 1750 

Ayvant Bendi İstanbul 156 000  13,45 1765 

Valide Bendi İstanbul 255 000 13,50 1796 

Kirazlı Bendi İstanbul 130 080 13,00 1818 

Yeni Bent İstanbul 217 500 17,00 1839 

Elmalı Bendi İstanbul 1 700 000 19,75 1893 
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Cumhuriyetin ilanından sonra özellikle 1930’lu yıllarda Ankara’ya içme suyu temin etmek 

amaçlı Çubuk I Barajı inşaatına başlanılmış ve 1936 yılında inşaatı tamamlanarak işletmeye 

açılmıştır. Bu özelliğinden dolayı Şekil 2.5’te Çubuk I Barajı, Cumhuriyet tarihimizin ilk barajı 

olarak tarihte yerini almıştır. İkinci Dünya Savaşı sonuna kadar birkaç küçük sulama amaçlı 

barajdan başka bir faaliyette bulunulmamış olup savaş sonrası ülkemizde baraj yapımı hız 

kazanmıştır (Akarun, 1983). 

 

Şekil 2.5. Cumhuriyet tarihimizin ilk barajı, Çubuk I Barajı 

Türkiye’de yıllık yağış miktarımız 574 mm olup ortalama 448 milyar m3 su potansiyeline 

karşılık gelmektedir. Bu suyun, buharlaşma yoluyla 246 milyar m3’lük kısmı atmosfere geri 

dönmekte, 63 milyar m3 yeraltı suyunu beslemekte, 140 milyar m3’ü akışa geçerek akarsular 

vasıtasıyla denizlere veya kapalı havza olan göllere akmaktadır. Yeraltı suyunu besleyen 63 milyar 

m3’lük suyun 25 milyar m3’ü kaynaklar vasıtasıyla yerüstü suyuna katılmaktadır. Ayrıca, komşu 

ülkelerden de 6 milyar m3 ortalama yılda su gelmektedir. Sonuç olarak ülkemizin yerüstü su 

potansiyeli (brüt) 171 (140+25+6) milyar m3 olmaktadır. Yeraltından çekilen 18 milyar m3 su ile 

birlikte ülkemizin yenilebilir su potansiyeli 189 (171+18) milyar m3 olarak hesaplanmıştır. Ancak, 
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teknik ve ekonomik şartlardan dolayı çeşitli amaçlar için tüketilebilecek toplam tüketilebilir yerüstü 

ve yeraltı su potansiyelimiz 100 milyar m3’tür. Şekil 2.6’da ülkemizin su kaynakları potansiyeli yer 

almaktadır. Ayrıca ülkemiz genelinde hidrolojik çalışmalar için 25 ana akarsu havzasına 

ayrılmıştır. Şekil 2.7’de ülkemizdeki hidrolojik havzalar ile Tablo 2.2’de havzalarımıza ait su 

potansiyelleri yer almaktadır (DSİ, 2018). 

 

Şekil 2.6. Türkiye'nin su kaynakları potansiyeli (DSİ, 2018) 

 

Şekil 2.7. Türkiye'deki 25 hidrolojik havza (DSİ, 2018) 
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Tablo 2.2. Türkiye'deki havzaların potansiyelleri (DSİ, 2018) 

HAVZA ADI 

(1 km3=1 Milyar m3) 

Yağış 

Alanı 

(km2) 

Ortalama Yıllık 

Yağış (km3) 

Potansiyel İştirak 

Oranı 

Ortalama Yıllık 

Verim (l/s/km2) 

(21) Dicle-Fırat Havzası* 184 918 49,91 29,2 9,0 

(22) Doğu Karadeniz H. 24 077 14,93 87 20,7 

(17) Doğu Akdeniz H. 22 048 8,24 4,8 12,0 

(09) Antalya Havzası 19 577 11,25 6,6 17,5 

(13) Batı Karadeniz H. 29 598 9,91 5,8 10,9 

(08) Batı Akdeniz H. 20 953 6,97 4,1 10,4 

(02) Marmara Havzası 24 100 7,54 4,4 10,3 

(18) Seyhan Havzası 20 450 6,79 4,0 9,7 

(20) Ceyhan Havzası 21 982 7,37 4,0 10,8 

(15) Kızılırmak Havzası 78 180 6,12 3,6 2,4 

(12) Sakarya Havzası 58 160 5,16 3,0 2,6 

(23) Çoruh Havzası 19 872 7,05 4,1 11,0 

(14) Yeşilırmak Havzası 36 114 6,58 3,8 5,3 

(03) Susurluk Havzası 22 399 4,23 2,5 5,5 

(24) Aras Havzası 27 548 4,18 2,4 4,7 

(16) Konya Kapalı H. 53 850 2,65 1,5 1,7 

(07) Büyük Menderes H. 24 976 2,97 1,7 3,6 

(25) Van Gölü Havzası 19 405 2,26 1,2 4,0 

(04) Kuzey Ege Havzası 10 003 1,50 0,9 4,8 

(05) Gediz Havzası 18 000 1,54 0,9 2,9 

(01) Meriç-Ergene H. 14 560 1,84 1,1 4,0 

(06) K. Menderes H. 6 907 0,53 0,3 2,4 

(19) Asi Havzası 7 796 0,89 0,5 3,6 

(10) Burdur Göller H. 6 374 0,26 0,1 1,3 

(11) Akarçay Havzası 7 605 0,33 0,2 1,9 

TOPLAM 779 452 171,00 100 6,9** 

*Fırat Alt Havzası yıllık akışı: 27 Milyar m3, Dicle Alt Havzası yıllık akışı: 22 Milyar m3 

**Ortalama Değerdir 

 

Kişi başına yıllık su potansiyeli 5000 m3 ve üzeri olan ülkeler “su zengini” kabul 

edilmektedir. Ancak, Türkiye İstatistik Kurumu (TÜİK) tarafından 2030 ülke nüfusumuzun 100 

milyon olacağı tahmin edildiğinden kişi başı su tüketim potansiyelimiz 1000 m3/yıl olacağı 

öngörülmüş olup bu da su zengini bir ülke olmadığımızı göstermektedir. Su zengini bir ülke 

potansiyeline sahip olmadığımızdan dolayı mevcut sahip olunan su kaynaklarının etkin ve verimli 

bir şekilde kullanılması zaruriyeti doğmaktadır. Sahip olunan sudan yararlanmak, enerji elde etmek 

ve akarsuları düzene sokmak için barajlar yapılmıştır ve yenilerinin de inşasına devam edilmektedir 

(DSİ, 2018). 

Uluslararası Büyük Barajlar Komisyonu (ICOLD)’a göre, temelden yüksekliği 15 m ve 

rezervuar hacmi 3 hm3 ve üzeri olan barajlar “büyük baraj” olarak adlandırılmaktadır. Bu 

standartlara göre Devlet Su İşleri (DSİ)  tarafından işletmeye alınan 783 adet ve diğer kurumlarca 

yapılan 86 adet olmak üzere ülkemizde 869 adet büyük baraj kapsamında barajımız bulunmaktadır. 

Ayrıca, inşa halinde olan toplam 873 adet baraj inşaatı da devam etmekte olup Tablo 2.3’te 

ülkemizdeki su yapılarına ait bilgiler yer almaktadır (DSİ, 2018). 
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Tablo 2.3. Türkiye'deki su yapıları (DSİ, 2018) 

Türkiye Su Yapıları İşletmede İnşa Halinde 

 DSİ Diğer Toplam DSİ Diğer Toplam 

BARAJ (adet) 783 86 869 399 474 873 

     (Büyük Su İşleri) 327 22 349 71 18 89 

     (Küçük Su İşleri) 456 64 520 328 456 784 

HES (adet) 67 560 627 2 60 62 

     (Kurulu Güç –MW) 12 560 15 640 28 200 1 760 2 640 4 400 

     (Yıllık Üretim-GWh) 45 200 53 000 98 200 6 000 7 600 13 600 

Gölet (adet) 474 633 1 107 120 80 200 

Sulama (Milyon ha) 4,2 2,3 6,5 1,26 - 1,26 

Evsel ve Sanayi Suyu (Milyar m3) 3,97 4,03 8,00 1,97 - 1,97 

Taşkın Kontrol (Mha) 1,9 - 1,9 0,5 - 0,5 

 

Ülkemizde barajlarımız gerek yüksekliklerine, gerek rezervuar hacimlerine, gerek gövde 

hacimlerine, gerekse sahip oldukları kurulu güçlere göre dünya literatürüne girmişlerdir. Bu 

barajlarımız ve diğer barajlarımız ülkemizin kalkınmasında önemli roller üstlenmektedir (Aşık, 

2016).  

2.3. Barajların Yıkılma Nedenleri 

Dünyada ilk baraj inşa edildiği andan itibaren tarih boyunca baraj yıkılma vakalarıyla 

karşılaşılmıştır. Baraj yıkılmaları gövdenin tümden göçmesi veya kısmi oyulma görülmesi de 

olmak üzere pek çok şekilde gerçekleşmektedir. Günümüzde meydana gelen baraj yıkılmaları 

incelendiğinde aşağıda belirtilen nedenlerin bir ya da birkaçı ile meydana geldiği söylenebilir 

(Abay, Baykan, & Baykan, 2015).  

1- Uzun süreli yağışlar ve taşkınlar 

2- Yetersiz dolusavak kapasitesi 

3- Borulanmayı ve sızmayı tetikleyen içsel aşınmalar 

4- İşletme aşamasında baraj ekipmanlarının yetersiz bakımı 

5- Uygun olmayan tasarım veya malzeme kullanımı 

6- Baraj gövdesinden suyun aşmasına neden olan yer kaymaları 

7- Baraj havzasının akış yukarısında bulunan başka bir barajın yıkılması 

8- Terörist saldırılar 

9- Baraj gövde üst kesimi boyunca çatlaklara neden olacak deprem oluşumları 

10- Baraj rezervuarının aşırı akım alması 

11- Yetersiz ve hatalı filtre malzemesi seçimi 

12- İnsan, tasarım ve bilgisayar hataları. 
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Baraj yıkılması ile ilgili en önemli sebepleri ise üç gruba ayırabiliriz (Paknıyat, 2015): 

a) Baraj gövdesi üstünden su aşması 

b) Temel hataları 

c) Baraj gövdesinde meydana gelen borulanma. 

Baraj gövdesi üzerinden suyun aşması, birçok nedenden dolayı olabilir ama genellikle 

dolusavak kapasitesinin yetersiz olmasından kaynaklanmaktadır. Ayrıca yeterli dolusavak 

kapasitesinin katı maddeler ile dolmasından da meydana gelmektedir. Böylece baraj gövdesinden 

aşan su aşınmaya neden olur ve barajın yıkılmasına sebep olur (Bayraktar, 2004). 

Baraj yıkılmasına neden olan temel hataları, temelin özelliklerinden kaynaklanacağı gibi 

yapım esnasında yapılan yanlış iyileştirmelerden de kaynaklanabilmektedir. Farklı oturmalar, 

çatlaklar, su sızıntıları gibi nedenler baraj temelinde hataların olduğunun belirtisi olabilmektedir. 

Ayrıca, tasarım aşamasında yanlış seçilen ve uygulanan temel malzemeleri de ciddi sorunların 

oluşmasına neden olmaktadır (Ağıralioğlu, 2011). 

Dolgu barajlarda geçirimsizliği sağlayan geçirimsiz zonda, sızan suların ince malzemeyi 

taşıması ile oluşan boşluklar zamanla boru gibi görev görmektedir. Su akımları bu boşluklardan 

geçerek zamanla boşlukların genişlemesine ve barajın yıkılmasına sebep olmaktadır (Zorluer, 

1999). 

2.4.  Baraj Tipleri İçin Muhtemel Yıkılma Türleri 

U.S Army Corsts Of Engineeers (USACE) Hidrologic Engineering Center tarafından baraj 

yıkılma nedenleri; heyelanlar, borulanma, taşkınlar, depremler, yetersiz veya hatalı baraj kısımları, 

temel hataları, rezervuarın hızlıca boşaltılması, membada bulunan başka barajların yıkılması, 

terörist saldırılar ve kontrollü yıkımlar olarak sıralamıştır. Aşağıdaki Tablo 2.4’te gösterildiği gibi 

baraj türlerine göre yıkılma modellerini sınıflandırmıştır (USACE, 2016).  

Tablo 2.4. Baraj tipleri için muhtemel yıkılma türleri (USACE, 2016) 

Yıkılma Modeli 
Toprak 

Dolgu 

Beton 

Ağırlık 

Beton 

Kemer 

Beton 

Payandalı 

Çok Amaçlı 

Beton 

Baraj üstünden su aşması U U U U U 

Borulanma/Sızma U U U U U 

Temel hataları U U U U U 

Kayma U U UD U UD 

Devrilme UD U U UD UD 

Yarılma U U U U U 

Kusurlu yapı bölümleri U U U U U 

(U: yıkılma modeli uygun, UD: yıkılma modeli uygun değil) 
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Uluslararası Büyük Barajlar Komisyonu (ICOLD), baraj yıkılmalarını araştırmak için bir çok 

çalışma yapmış ve yıkılma istatistiklerini yayınlamıştır. Çin Halk Cumhuriyeti dışında dünyada 

900 den fazla baraj yıkılmasının incelendiği çalışmada baraj yıkılma bilgileri ve karakteristik 

bilgileri toplanarak, Şekil 2.8’de baraj türlerine göre yıkılma yüzdeleri belirlenmiştir (Zhang, Xu, 

& Jia, 2009). 

 

 

Şekil 2.8. Baraj türlerine göre yıkılma yüzdeleri (Zhang, Xu, & Jia, 2009) 

2.5. Tarihteki Baraj Yıkılma Olayları 

Yıkıldıkları zaman büyük taşkınların oluşmasına sebep olan barajlar son iki yüz yılın yıkıcı 

felaketlerinden olmuştur. Baraj yıkılmalarından sonra meydana gelen taşkınların vereceği maddi 

hasarlar kaçınılmazken can kayıplarının oluşması da muhtemeldir. Oluşabilecek olan can kayıpları; 

mevcut taşkın alanlarına,  nüfus yoğunluğuna ve erken uyarı sistemlerine bağlı olarak 

değişebilmektedir. Can ve mal kaybına neden olabilecek baraj yıkılma karakteristiklerini iyi 

belirlemek bu yüzden büyük öneme sahiptir (Palamut, 2014). 

Amerika Birleşik Devleti’nde 1889 yılında South Fork Barajı, aşırı yağışlardan dolayı 

rezervuardaki suyun gövde üzerinden aşması neticesinde 12 m yüksekliğinde dalgaların oluşmasına 

ve 2200 kişinin ölümüne sebep olmuştur (Palamut, 2014). 

İtalya’da 1963 yılında beton kemer tipinde inşa edilmiş ve 267 m yüksekliğinde olan Şekil 

2.9’da gösterilen Vajont Barajı rezervuarında meydana gelen heyelandan dolayı baraj 

rezervuarındaki sular taşmış ve mansabında bulunan yerleşim alanlarında tsunami etkisi yaratarak 

2000’den fazla insanın hayatını kaybetmesine neden olmuştur (Elçi, Tayfur, Haltaş, & Kocaman, 

2017). 

65,50%
7,75%

6,70%

4,50%

2,50% 13,30%

Toprak

Beton

Kagir

Kaya Dolgu

Diğer

Bilinmeyen
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Şekil 2.9. İtalya'daki Vajont Barajı (URL-1, 14 Haziran 2020) 

Çin’de 1975 yılında Şekil 2.10’da gösterilen Banqiao ve Shimantan Barajları ile birlikte 62 

adet küçük barajın aşırı yağışlardan dolayı yıkılması sonucu 26 000 kişi yaşamını yitirmiştir. 

Ayrıca; yaşanan taşkından sonra meydana gelen salgın hastalıklar ve açlık gibi nedenlerden dolayı 

da 145 000 kişi hayatını kaybetmiştir (Abay, Baykan, & Baykan, 2015).  

 

Şekil 2.10. Çin'deki Banqiao Barajı (URL-2, 10 Mayıs 2020) 

ABD’de 1976 yılında 93 m yüksekliğinde olan ve kaya dolgu tipinde inşa edilen Teton 

Barajı, rezervuarında ilk su tutulmasından hemen sonra gövdesinde meydana gelen ve Şekil 2.11’de 

görülen borulanmadan dolayı yıkılmış ve 10 kişi yaşamını yitirmiş, 2000 kişi yaralanmış, 135 kişi 

kaybolmuş ve 7000’den fazla konut ve iş yeri zarar görmüştür (Uysal, 1976). 
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Şekil 2.11. ABD'deki Teton Barajı (Uysal, 1976) 

Dünyada meydana gelen baraj yıkılmaları sonucu ortalama 170 000 kişi yaşamını yitirmiştir. 

Dünya tarihinde gerçekleşen baraj yıkılmaları, yıkılma nedenleri ve yaşanan can kayıplarına ait 

bilgiler Tablo 2.5’te verilmiştir (Abay, Baykan, & Baykan, 2015). 

Tablo 2.5. Dünyada gerçekleşen önemli baraj yıkılmaları (Abay, Baykan, & Baykan, 2015) 

Sıra Baraj Yıl Ülke Ölü Sayısı Yıkılma Nedeni 

1 Banqiao/Shimantan 1975 Çin 171 000 Kadastrofik yağış 

2 Machchu 2 1979 Hindistan 5 000 Üstten su aşması 

3 Sempor 1967 Endonezya >2 000 Üstten su aşması 

4 South Fork 1889 ABD 2 209 Aşırı yağış 

5 Vaiont 1963 İtalya 2 000 Üstten su aşması 

6 Tigra 1917 Hindistan 1 000 Temele su sızması 

7 Panshet 1961 Hindistan 1 000 Gövde yıkılması 

8 Puentes 1802 İspanya 608 Yumuşak zemin 

9 St. Frasncis 1928 ABD 600 Jeolojik duyarsızlık 

10 Malpesset 1959 Fransa 423 İnşaat aşamasında 

11 Gleno 1923 İtalya 356 Hatalı tasarım ve inşaat 

12 Val di Stava 1985 İtalya 268 Hatalı tasarım ve inşaat 

13 Koshi 2008 Nepal 250 Aşırı yağış 

14 Dale Dike 1864 İngiltere 244 Hatalı inşaat 

15 Canyon Lake 1972 ABD 238 Taşkın 

16 Kantale 1986 Siri Lanka 180 Hatalı işletme 

17 Tangiwai 1953 Yeni Zelenda 151 Krater göl taşması 

18 Bouzey 1884 Cezayir 150 Kayma 

19 Vega de Tera 1959 İspanya 144 Gövde yıkılması 

20 Mill Nehri 1874 ABD 139 Hatalı tasarım 

21 Buffalo Creek 1972 ABD 125 Aşırı yağış 

22 Sella Zerbino 1935 İtalya 111 Taşkın 

23 Vratsa 1966 Bulgaristan 107 Taşkın 

24 Situ Gintung 2009 Endonezya 98 Aşırı yağış 

25 Certej 1971 Romanya 89 Hatalı tasarım 

26 Bilberry 1852 İngiltere 81 Türbin kopması 

27 Austin 1911 ABD 78 Kasıtlı yıkım 

28 Sayanı/Shushenskaya 2009 Rusya 75 Aşırı yağış 

29 Shajidor 2005 Pakistan 70 Aşırı yağış 



3. ÇALIŞMA ALANI 

3.1. Proje Alanı Hakkında Genel Bilgi 

Çalışma alanı, Marmara Bölgesi’nde Bursa İli, Karacabey İlçesi sınırlarında kalmaktadır. 

Baraj yeri Karacabey İlçesi’ne 25 km mesafede ve Yeşildere Mahallesi’nin 1 km kuzeyinde yer 

almaktadır. Yeşildere Barajı, Susurluk Çayı’na katılan yan kollardan olan Karadere’ye bağlanan 

Karaniç Deresi üzerinde bulunmakta olup Şekil 3.1’de çalışma alanının yeri gösterilmektedir.  

 

Şekil 3.1. Çalışma alanının Türkiye’deki yeri 

3.2.  Yeşildere Barajı 

Yeşildere Barajı, “Ön Yüzü Beton Kaplamalı Kaya Dolgu Baraj” proje sahası Yeşildere 

Mahallesine 1 km mesafededir. Barajın talvegden yüksekliği 57,90 m, temelden yüksekliği 59,50 

m’dir. Baraj gövdesi topla dolgu hacmi 740 327 m3’tür. Derivasyon tüneli sol sahilde 3,00 m iç 

çapında ve 407,04 m uzunluğundadır. Dolusavak sağ sahilde, karşıdan alışlı ve kontrolsüzdür. Şekil 

3.2’de baraj gövdesinin genel yerleşim planı ve Şekil 3.3’te de baraj gövdesine ait enkesit 

gösterilmektedir. Ayrıca; Şekil 3.4 ve 3.5’te baraj inşaatına ait imalat görüntüleri yer almaktadır. 
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Şekil 3.2. Baraj gövdesi genel yerleşim planı 

 

Şekil 3.3. Baraj gövdesi enkesiti 
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Şekil 3.4. Yeşildere Barajı memba görünüşü 

 

Şekil 3.5. Yeşildere Barajı mansap görünüşü 
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3.3. Yeşildere Barajı Karakteristik Bilgileri 

Bu tez çalışmasının konusu olan Yeşildere Barajının gövde inşaatı devam etmekte olup 

baraja ait karakteristik bilgiler Tablo 3.1’de gösterilmektedir (DSİ, 2001). 

Tablo 3.1. Yeşildere Barajı karakteristik bilgileri (DSİ, 2001) 

Amacı :  Sulama 

Hidroloji ve Su Kullanımı  

Drenaj Alanı :  34,38 km2 

Yıllık Ortalama Akım :  15,42 hm3 

Göl  

Minimum İşletme Kotu :  95,29 m 

Normal Su Seviyesi :  133,86 m 

Maksimum Su Kotu :  135,95 m 

Hacim - Minimum Su Seviyesi :  0,45 hm3 

Hacim - Normal Su Seviyesi :  15,62 hm3 

Hacim - Maksimum Su Seviyesi :  16,07 hm3 

Baraj  

Tipi :  Ön Yüzü Beton  Kaplamalı Kaya Dolgu 

Kret Kotu / Parapet Kotu :  135.50 m / 137.00 m 

Talveg Kotu :  79,50 m 

Barajın Talvegden Yüksekliği (parapet  ile) :  57,50 m 

Barajın Temelden Yüksekliği (parapet  ile) :  59,50 m 

Kret Uzunluğu :  318,95 m 

Kret Genişliği :  8,00 m 

Toplam Gövde Hacmi :  740 327 m3 

Memba Şevi :  1 / 1,4 

Mansap Şevi :  1 / 1,4 

Dolusavak  

Yeri :  Sağ sahil 

Tipi :  Karşıdan Alışlı, Kontrolsüz 

Taşkın Debisi (MMF/10000) 

Dolusavak Kapasitesi 

Dolusavak Kret Uzunluğu 

:  285,35 m3/s 

:  122.85 m3/s 

:  20 m 

Dolusavak Kret Kotu 

Eşik Yüksekliği 

:  133,90 m 

:  1.50 m 

Dolusavak  Teknesi Boyu 

Deşarj Kanalı Genişliği 

Enerji Kırıcı Havuz Boyu (Tip II) 

Enerji Kırıcı Havuz Taban Kotu 

:  222,67 m 

:  28 m 

:  12 m 

:  76,50 m 

Derivasyon Tüneli ve Dipsavak  

Dipsavak Tipi :  Tünel + Atnalı Kesit 

Tünel Giriş Taban Kotu 

Tünel Çıkışı Taban Kotu 

Tünel Eğimi 

Tünel Uzunluğu 

Tünel İç Çapı 

Derivasyon Taşkın Debisi (Q50) 

 

:  85,50 m 

:  79,06 m 

:  1,45 

:  407,04 m 

:  3 m 

:  86.86 m3/s  
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3.4. Yeşildere Barajı Deprem Durumu 

Yeşildere Barajı ve civarında Kuzey Anadolu Fay Zonu bulunmakta olup Anadolu’nun en 

büyük fay zonlarındandır. Yeşildere Barajı aks yerinde 50 yıllık bir ekonomik ömür için %5 

olasılıkla aşılması beklenen yer ivmesi a=364 cm/sn2 veya a=0,371 g.’dir. 100 yıllık bir zaman 

periyodu içerisinde %20 aşılma olasılığı ile meydana gelmesi beklenen yatay yer hareketi deprem 

ivmesi ise a=271 cm/sn2 veya a=0,276 g. olarak hesaplanmıştır (DSİ, 2001). Şekil 3.6’da yer alan 

Türkiye Deprem Tehlike Haritası’nda da görüldüğü gibi çalışma alanına ait 50 yıllık %10 olasılıkla 

aşılması beklenen en büyük yer ivmesinin a=0,282 g.’den fazla olduğu görülmektedir (AFAD, 

2018). 

 

  

Şekil 3.6. Türkiye Deprem Tehlike Haritası (AFAD, 2018) 

 



4. MATERYAL VE METOT 

Bu tez çalışmasının temel amacı ekstrem yağış, yapısal problemler veya deprem gibi 

nedenlerle oluşabilecek olası bir baraj yıkılmasının iki boyutlu taşkın analizinin yapılması, 

Yeşildere Barajı mansabındaki yerleşim yerlerinin taşkın yayılım, tehlike ve risk haritalarının 

oluşturularak, oluşacak taşkının maksimum su seviyelerinin ve oluşma zamanlarının 

belirlenmesidir. 

Tez çalışmasının bu bölümü iki kısımdan oluşacak olup, birinci kısımda iki boyutlu taşkın 

analizinde kullanılan programlar hakkında genel bilgiler verilecektir. İkinci kısımda ise programlar 

vasıtasıyla baraj yıkılma analizi yapılarak taşkın yayılım haritaları oluşturulacaktır. 

4.1. Çalışmada Kullanılan Programlar 

4.1.1. Netcad 5.1 Programı Hakkında Genel Bilgiler 

Netcad, 1989 yılında iki Türk tarafında geliştirilen GIS tabanlı bir yazılımdır. CBS, CAD, 

şehir planlama, jeoloji, tarım, haritalama, madencilik gibi geniş alanlarda çözüm üretmemize 

yardımcı olmaktadır (Bulan, 2019). 

Birçok alt modülü bulunan Netcad programı yol, imar işleri, baraj, halihazır harita, 

parselasyon harita yapımı gibi birçok alanda kullanıcılara kolaylık sağlamaktadır. (Dere, 2019). 

Netcad çok geniş ve çeşitli uygulama alanına sahiptir. Bu uygulama alanlarına ait kullanılan 

çözümleri üç gruba ayırabiliriz. Bunlar; 

1- CBS-GIS Çözümleri ve Uygulamaları: Masaüstü, web, mobil ve bulut teknolojisinde 

kullanılmaya elverişli bir programdır.   

2- Mühendislik Çözümleri ve Uygulamaları: Harita alanında, altyapı alanında, şehir ve 

bölge planlamasında, inşaat alanında, jeoloji alanında, hidroloji alanında, ziraat 

alanında, elektrik alanında ve çevre alanındaki mühendisliklere yönelik 30’dan fazla 

çözüm yöntemi ve uygulamaları mevcuttur. 

3- Belediye Çözümleri ve Uygulamaları: Halihazır haritaların, imar haritalarının, 

taşınmazların kadastral ve mülkiyet durumları gibi belediyecilik konularında yardımcı 

uygulamaları mevcuttur (Akbaş, 2019).  

4.1.2. ArcMAP 10.1 Programı Hakkında Genel Bilgiler 

ArcGIS, ESRI tarafından geliştirilen ve ölçeklendirme yapabilen bir coğrafi bilgi sistemi 

(CBS) yazılımıdır. ArcObjects üzerinden ortak veri kütüphanesi kurulmuş bir sistemdir. ArcGIS 

yazılımı, bilgilerin depolanması, işlenmesi, analiz edilmesi, haritaların oluşturulması, 
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projelendirme özelliğinin bulunması ve bununla birlikte insan gücünden ve paradan tasarruf etmeyi 

sağlayan, harita ve coğrafi bilgiler doğrultusunda çalışan bir yazılımdır (Bulan, 2019). 

ArcGIS yazılımı aşağıda belirtilen temel kısımlardan oluşmaktadır: 

1- ArcGIS Desktop: CBS uygulamalarının ileri düzey işlem yapılmasını sağlamaktadır.  

2- ArcGIS Mobile: Özel CBS uygulamalarının arazi çalışmalarında kullanılmasını 

sağlamaktadır. 

3- ArcGIS Online: CBS yazılım uygulamaların web üzerinden kullanıcılara ulaşmasını 

sağlayan kütüphanedir. 

4- ArcGIS Engine: .NET, Java ve C++ uygulamalarının geliştirilmesi için yazılım 

kütüphanesi sağlamaktadır. 

5- ArcGIS Server: CBS ile oluşturulan haritaların web üzerinden kullanıcılara sunulması ve 

geliştirilmesine imkan sağlamaktadır (Töreyen, Özdemir , & Kurt, 2010).  

4.1.3. HEC-RAS 5.0.6 Programı Hakkında Genel Bilgiler 

HEC-RAS (Hydrologic Engineering Centers River Analysis System), USACE (ABD Ordusu 

Mühendisler Birliği) tarafından geliştirilen sürekli akımlara ait su yüzü profillerini hesaplayan ve 

süreksiz akımlara ait modelleme yapabilen bir programdır.  

HEC-RAS programının kullanıcı arayüzünde, çalışılacak projelere ait dosya verilerin 

girilmesi, analiz yapılmadan önce veri girişlerinin yapılması, hidrolik analiz yapılması, analiz 

sonuçlarının çıktı tablolarının oluşturulması, sonuçların grafiksel olarak gösterilmesi, çalışma 

sonuçlarının haritalandırılması ve su yayılım simülasyonlarının oluşturulması gibi hizmetleri 

içermektedir (Kuşoğlu, 2019).   

HEC-RAS bir ve iki boyutlu hidrolik hesaplamalar yapmak için tasarlanmış ve çeşitli analiz 

bileşenleri bulundurmaktadır. Yapısında bulundurduğu bileşenler, kararlı akımlarım su yüzü 

profillerinin oluşturulmasını, bir ve iki boyutlu kararsız akım simülasyonlarının oluşturulmasını, 

sediment taşınım hesaplarını ve su kalitesi analizlerinin yapılmasını sağlamaktadır (Kuşoğlu, 

2019). 

HEC-RAS programı kararlı akım hesaplamalarında tek bir nehir veya daha karmaşık nehir 

sistemlerinde su yüzü profillerini kritik altı, kritik üstü ve karışık akım rejimlerine göre 

modelleyebilmektedir. Tek boyutlu enerji denklemi HEC-RAS hesaplamalarının temel prensibini 

oluşturmaktadır. Manning Denklemleri ile sürekli yük kayıplarını ve kanala ait daralma/genişleme 

katsayıları ile de yersel yük kayıplarını hesaplayarak enerji kayıplarını bulmaktadır. Ayrıca; su 

yüzü profillerinin ani değiştiği, karışık akım rejimi hesaplarını meydana getiren hidrolik 

sıçramaları, nehirlerin birleştiği kavşakları ve köprü hidroliği hesaplarında Momentum 

Denklemlerini kullanmaktadır (HEC-RAS, 2020). 
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HEC-RAS programı kararsız akım hesaplamalarını yaparken kritik, süper kritik ve karışık 

akış rejimlerini kullanmaktadır. Bir ve iki boyutlu akım simülasyonları yapan program baraj 

yıkılma analizi, taşkın duvarlarının yıkılması/devrilmesi ve basınçlı boru sistemleri gibi karmaşık 

hidrolik hesaplamaların analizlerini de bünyesinde barındırmaktadır (Kuşoğlu, 2019). 

HEC-RAS programı açık kanallarda sediment birikinti boyutlarının değerlendirilmesi, 

nehirlerde gerçekleşen daralmaların kontrol edilmesi, ciddi seviyede yaşanan taşkınların meydana 

getirdiği zararın tahmin edilmesi çalışmalarında ve yapay kanallarda sedimentleşme oranları 

hesaplarını gerçekleştirmektedir (HEC-RAS, 2020).  

HEC-RAS programı, kanal ve taşkın modellemesinde Navier-Stokes denklemlerinin 

sadeleştirilmiş bir formu olan Saint Venant denklemleri veya Difüzyon Dalga denklemlerini 

kullanmaktadır. Navier-Stokes denklemleri, denklem 4.1 ve 4.2’de yer alan süreklilik ve 

momentum denklemlerinden oluşmaktadır.  

∂ρ

∂𝑡
+ 𝑉 ̅(ρV) = 0  (4.1) 

𝜌
𝑑𝑉

𝑑𝑡
= − 𝑉 ̅p + 𝑉 ̅τ + ρg (4.2) 

Denklemlerde yer alan; ρ yoğunluğu, g yer çekimi ivmesi, t zamanı, τ gerilme tensörü, p 

basınç ve V hız vektörü olarak gösterilmektedir. Bu denklemlerde düşey ivme ihmal edilerek 

denklemlerin indirgenmeleri sağlanarak sığ akım denklemlerine geçilmektedir. Saint Venant 

denklemlerine ait süreklilik ve momentum denklemleri, denklem 4.3 ve 4.4’te yer almaktadır 

(Kocaman S. , 2007). 

∂Q

∂𝑥
+

∂𝐴

∂𝑡
= 0  (4.3) 

(𝑘𝑡) (
∂Q

∂𝑡
) + (𝑘𝑐)

𝜕

𝜕𝑥
(

𝑄2

𝐴
) + (𝑘𝑝)𝑔𝐴 (

𝜕ℎ

𝜕𝑥
) −  (𝑘𝑓)𝑔𝐴 (𝑆0 − 𝑆𝑓)  = 0 (4.4) 

Denklem 4.4’te yer alan momentum denklemi yersel ivme, konvektif (taşınsal) ivme, basınç 

kuvveti ve sürtünme değerlerinden meydana gelmektedir. Momentum denkleminde yer alan 

terimlerin tamamının dikkate alınması (kt=kc=kp=kf=1) sonucu yapılan hesaba Full Saint-Venant 

(Full Momentum) denklemi denilmektedir. Full Momentum denkleminde yersel ivme ile konvektif 

ivmenin ihmal edildiği (kt=0, kc=0, kp=kf=1) Ataletsiz Dalga çözümüne Difüzyon Dalga Denklemi 

adı verilmektedir (Kaya & Ülke , 2012). 

HEC-RAS programı iki boyutlu (2D) çözümlerde öncelikli olarak Difüzyon Dalga 

Denklemini kullanır veya istenildiğinde Full Momentum Denklemi opsiyonu seçilerek çözüm 

yapılabilir. Difüzyon Dalga Denklemi, Full Momentum denklemine göre genellikle daha stabil 

çözüm yapmaktadır. Taşkın dalgası modellemelerinde her iki denklem seti de kullanılarak 
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sonuçları karşılaştırılmalı ve sonuçlar arasında belirgin bir fark varsa Full Momentum Denklemi 

sonuçları daha doğru kabul edilerek simülasyona devam edilmelidir (Ardıçlıoğlu, 2020).  

HEC-RAS programında, baraj yıkılma analizlerinde 5 adet taşkın tahmin metodu 

kullanmaktadır. Bunlar; Singh ve Snorrason, MacDonald ve Langridge-Monopolis, Bureau of 

Reclamation, Von Thun & Gillette ve Froehlich olan taşkın tahmin metodlarıdır (Ergen, 2019). 

Singh ve Snorrason, 20 adet yaşanmış ve 8 adet simüle edilmiş baraj yıkılma çalışmaları 

üzerinde 1984 yılında yaptıkları çalışmalarında istatistiki veriler elde etmişlerdir. Bu veriler 

doğrultusunda taban yıkılma genişliğini (𝐵𝑏, 𝑚𝑒𝑡𝑟𝑒), baraj yüksekliğine (ℎ𝑏, 𝑚𝑒𝑡𝑟𝑒) bağlı olarak 

tanımlamışlardır. Ayrıca tamamen barajın yıkılması süresi (𝑡𝑓 , 𝑠𝑎𝑎𝑡) içinde tahminde 

bulunulmuştur. Taban yıkılma genişliği ve yıkılma süresi tahminlerine ait denklemler 4.5 ve 4.6’de 

gösterilmektedir (Singh & Snorrason, 1984). 

2ℎ𝑑(𝑚) ≤ 𝐵𝑏(𝑚) ≤ 5ℎ𝑑(𝑚)  (4.5) 

0.25 ≤ 𝑡𝑓(𝑠𝑎𝑎𝑡) ≤ 1.0   (4.6) 

MacDonald ve Langridge-Monopolis, 42 adet baraj yıkılması üzerinde incelemelerde 

bulunarak baraj yıkılma parametreleri arasındaki ilişkiyi bulmaya çalışmışlardır. Barajın yıkılma 

süresince (𝑡𝑓 , 𝑠𝑎𝑎𝑡) baraj rezervuarında boşalacak suyun hacmi (𝑉𝑤 , 𝑚𝑒𝑡𝑟𝑒𝑘ü𝑝), yıkılma 

sonrasında baraj gövdesinden akacak malzemenin hacmi (𝑉𝑚, 𝑚𝑒𝑡𝑟𝑒𝑘ü𝑝) ve barajın yıkılmadan 

önceki su yüksekliği ile yıkıldıktan sonra baraj tabanı arasındaki su yüksekliği (ℎ𝑤 , 𝑚𝑒𝑡𝑟𝑒) gibi 

baraj parametrelerini birbirleri ile ilişkilendirmişlerdir. Barajların yıkılma eğimlerinin de 1 yatay 2 

düşey oranında alınabileceği belirtilmiştir. Toprak dolgu barajlardan çıkan malzeme miktarını 

hesaplamak için Denklem 4.7’in kullanılmasını, kil çekirdekli toprak dolgu ve kaya dolgular için 

ise çıkan malzeme miktarının Denklem 4.8’in belirtilen formüllerle bulunmasını önermişlerdir. 

Baraj yıkılma süresini bulmak için Denklem 4.9’un ve maksimum debinin (𝑄𝑝𝑖𝑘 , 𝑚𝑒𝑡𝑟𝑒𝑘ü𝑝)  

bulunması içinde Denklem 4.10’un kullanılmasını belirtmişlerdir (MacDonald & Langridge-

Monopolis, 1984). 

𝑉𝑚 = 0.0261 ∗ (𝑉𝑤 ∗ ℎ𝑤)0.769  (4.7) 

𝑉𝑚 = 0.00348 ∗ (𝑉𝑤 ∗ ℎ𝑤)0.852  (4.8) 

𝑡𝑓 = 0.0179 ∗ (𝑉𝑚)0.364   (4.9) 

𝑄𝑝𝑖𝑘 = 1.154 ∗ (𝑉𝑤 ∗ ℎ𝑤)0.412   (4.10) 

Bureau of Reclamation, 21 adet baraj yıkılma çalışması sonucunda, baraj rezervuar su 

yüksekliğinin (ℎ𝑤, 𝑚𝑒𝑡𝑟𝑒) baraj yıkılma ortalama genişliğini (𝐵̅, 𝑚𝑒𝑡𝑟𝑒) etkilediğini belirterek 

Denklem 4.11’de ki eşitliği bulmuştur. Ayrıca baraj yıkılmasının tamamlanma süresini (𝑡𝑓 , 𝑠𝑎𝑎𝑡) 
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baraj ortalama genişliğinin 0.011 katsayısı ile çarpılarak bulunabileceğini belirterek Denklem 

4.12’nin uygulanmasını önermiştir (Reclamation, 1982). 

𝐵̅ = 3 ∗ ℎ𝑊  (4.11) 

𝑡𝑓 = 0.011 ∗ 𝐵̅  (4.12) 

Von Thun ve Gillette, 57 adet baraj yıkılması olayını inceleyerek, ortalama baraj yıkılma 

genişliğini (𝐵̅, 𝑚𝑒𝑡𝑟𝑒), rezervuardaki su yüksekliği (ℎ𝑤 , 𝑚𝑒𝑡𝑟𝑒)  ile rezervuar hacmine bağlı olan 

(𝐶𝑏, 𝑚𝑒𝑡𝑟𝑒) katsayısının toplamı ile bulunacağını önererek Denklen 4.13’ü bulmuştur. Denklemde 

kullanılan 𝐶𝑏 değeri ise Tablo 4.1’de yer almaktadır. Yan eğimlerinde genel olarak 1 yatay ve 1 

düşey alınabileceğini ancak kohezyon çekirdekli barajlarda 1 yatay ve 1 düşey yada 1 yatay ve 3 

düşey alınmasının daha uygun olacağını belirtmiştir. Ayrıca baraj yıkılma süresi için de malzeme 

cinsine bağlı olarak Denklem 4.14 ve 4.15 gibi iki farklı denklemi önermiştir (Von Thun & Gillette, 

1990). 

𝐵̅ = 2.5 ∗ ℎ𝑊 + 𝐶𝑏  (4.13) 

Yüksek aşınmaya sahip malzeme  {
𝑡𝑓 = 0.015 ∗ ℎ𝑊          

𝑡𝑓 = 𝐵̅/(4 ∗ ℎ𝑊 + 61)
                    (4.14) 

 

Aşınmaya dirençli malzeme  {
𝑡𝑓 = 0.015 ∗ ℎ𝑊 + 0.25      

𝑡𝑓 = 𝐵̅/(4 ∗ ℎ𝑊) 
         (4.15) 

Tablo 4.1. Rezervuar büyüklüğüne göre Cb katsayısı 

Rezervuar Büyüklüğü (m3) 𝑪𝒃(𝒎) 

<1.23*106 6.1 

1.23*106 ~ 6.17*106 18.3 

6.17*106 ~ 1.23*107 42.7 

>1.23*107 54.9 

 

Froehlich, 1995 yılında 63 adet ve 2008 yılında ise 74 adet baraj yıkılma olaylarını 

inceleyerek baraj yıkılma parametreleri ile ilgili aşağıdaki Denklem 4.16 ile 4.21 arasındaki 

denklemleri önermiştir (Froehlich, 2008). 

𝐵̅ = 0.27 ∗ 𝑘0 ∗ 𝑉𝑊
1/3

  (4.16) 

𝑡𝑓 = 63.2 ∗ √
𝑉𝑊

𝑔∗ℎ𝑏
2  (4.17) 
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𝑘0 {
1.3 ü𝑠𝑡𝑒𝑛 𝑦𝚤𝑘𝚤𝑙𝑚𝑎 𝑖ç𝑖𝑛
1.0 𝑑𝑖ğ𝑒𝑟 𝑦𝚤𝑘𝚤𝑙𝑚𝑎𝑙𝑎𝑟

  (4.18) 

𝑧 =
𝑉

𝐻
= {

1.0 ü𝑠𝑡𝑒𝑛 𝑦𝚤𝑘𝚤𝑙𝑚𝑎 𝑖ç𝑖𝑛
0.7 𝑑𝑖ğ𝑒𝑟 𝑦𝚤𝑘𝚤𝑙𝑚𝑎𝑙𝑎𝑟

  (4.19) 

𝐵𝑡 = 𝐵̅ −
𝑉

ℎ𝑑
∗ ℎ𝑏  (4.20) 

𝑄𝑝𝑖𝑘 = 0.607 ∗ 𝑉𝑊
0.295 ∗ ℎ𝑊

1.24  (4.21) 

Yukarıdaki denklemlerde, baraj yıkılma genişliği (𝐵̅, 𝑚𝑒𝑡𝑟𝑒), yıkılma anındaki rezervuar su 

hacmi (𝑉𝑤 , 𝑚𝑒𝑡𝑟𝑒𝑘ü𝑝), baraj yıkılma süresi (𝑡𝑓 , 𝑠𝑎𝑎𝑡), yıkılma anındaki su yüksekliği 

(ℎ𝑏 , 𝑚𝑒𝑡𝑟𝑒), baraj yüksekliği (ℎ𝑑 , 𝑚𝑒𝑡𝑟𝑒), nihai baraj yıkılma taban genişliği (𝐵𝑡 , 𝑚𝑒𝑡𝑟𝑒) ve 

maksimum debi (𝑄𝑝𝑖𝑘 , 𝑚𝑒𝑡𝑟𝑒𝑘ü𝑝) olarak gösterilmektedir. 

4.2. İki Boyutlu Taşkın Modelleme 

Bursa Karacabey Yeşildere Barajının yıkılma analizi için Netcad, ArcGIS ve HEC-RAS 

programları kullanılmıştır. Belirtilen programlarda aşağıda belirtilen işlem basamakları yapılarak 

taşkın yayılım haritaları oluşturulmuş ve taşkın dalgalarının maksimum su yükseklikleri ile 

yerleşim yerine ulaşma süreleri bulunmuştur. 

4.2.1. ArcGIS Programında Yapılan İşlemler 

Bu çalışmada, Bursa Su ve Kanalizasyon İdaresi (BUSKİ) tarafından hava fotoğrafları ile 

DGN formatında üretilen 1/1000 ölçekli halihazır haritalar altlık olarak kullanılmıştır. 1/1000 

ölçekli ve DGN formatındaki halihazır haritalar NetCAD programında açılarak çalışmada 

kullanılacak tabakalar (yapı tabakaları ve eş yükselti eğrileri ayrıştırılmış ayrıca gereksiz katmanlar 

silinmiştir) düzenlenerek Cad formatında kaydedilip ArcGIS’e eklenmiştir. 

 ArcGIS yazılımı ile eşyükselti eğrilerinin mevcut araziyi yansıtabilmesi için yüzey 

modellemesi yapılmalıdır. Düzensiz üçgen ağı adı verilen sayısal yükseklik modelinin TIN 

(Triangulated Irragular Network) oluşturulması gerekmektedir. TIN verisi: ArcToolbox → 3D 

Analyst Tools → Data Management → TIN → Create TIN adımları ile oluşturulmuştur. Şekil 

4.1’de çalışma alanına ait oluşturulan sayısal yükseklik modeli görülmektedir. 
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Şekil 4.1. Çalışma alanına ait TIN verisi 

ArcGIS’te oluşturulan TIN verisinin doğru olup olmadığı incelenmiş ve mevcut araziyi 

yansıttığından emin olunduktan sonra raster veri formatına dönüşüm işleminin yapılması 

gerekmektedir. Raster verisi: ArcToolbox → 3D Analyst Tools → From TIN → TIN to Raster 

adımları ile oluşturulmuştur. Şekil 4.2’de çalışma alanının raster verisi görülmektedir. 
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Şekil 4.2. Çalışma alanına ait raster veri 

Netcad ortamında binalar ayrılarak ArcGIS’e line (çizgi) olarak alınmış ve binaların taşkın 

alanındaki etkisinin görülmesi sağlanmıştır. ArcGIS’e aktarılan bina katmanı line katmanından 

polygon formatına çevrilmesi gerekmektedir. Polygon formatı için: ArcToolbox → Data 

Management Tools → Features → Feature to Polygon araçları kullanılmış ve bina katmanı 

polygona çevrilerek Şekil 4.3’te gösterilmektedir. 
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Şekil 4.3. Polygon formatına çevrilmiş binalar 

Polygon formatında bulunan bina katmanlarını raster formatına çevrilmesi gerekmektedir. 

Raster formatı: ArcToolbox → Conversion Tools → To Raster → Polygon to Raster adımları ile 

bina katmanları raster formata çevrilmiştir. Raster formata dönüştürülen binalar Şekil 4.4’te 

görülmektedir. 
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Şekil 4.4. Raster formatına dönüştürülmüş bina katmanı 

Şekil 4.2.’de araziye ait raster veri ile Şekil 4.4.’de binalara ait olan raster veriler 

birleştirilerek nihani HEC-RAS programında kullanılacak raster verisi elde edilecektir. Nihai raster 

verisi: ArcToolbox → Data Management Tools → Raster → Raster Dataset → Mosaic to New 

Raster adımları ile oluşturulmuştur. Şekil 4.5.’te oluşturulan ve HEC-RAS programında 

kullanılacak olan raster verisi gösterilmektedir. 
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Şekil 4.5. Birleştirilmiş nihai raster veri 

4.2.2. HEC-RAS Programında Yapılan İşlemler 

HEC-RAS programı ile yeni bir proje oluşturularak ArcGIS ortamında oluşturulan nihai 

raster verinin doğru yeri temsil etmesi ve çalışabilmesi için birim sisteminin HEC-RAS’ta 

tanımlanması gerekmektedir. ArcGIS’te birim sistemi olarak metrik sistem (System International-

SI) kullanılmıştır. Metrik sistem: Options → Unit System → System International adımları ile 

oluşturulmuştur. Şekil 4.6’da metrik sistemin seçim ekranı görülmektedir.  
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Şekil 4.6. Nihai raster veriye ait birim özelliği 

Ayrıca ArcGIS programı ile raster veri oluşturulurken ED_1950_TM27 projeksiyon sistemi 

kullanılmıştır. HEC-RAS programında kullanılan raster verilerin çalışma alanımızı doğru temsil 

etmesi için projeksiyon sisteminin tanımlanması gerekmektedir. Projeksiyon sistemi: GIS Tools → 

RAS Mapper → Tools → Set Projection adımları ile tanımlanmış ve Şekil 4.7’de gösterilmektedir. 

 

Şekil 4.7. HEC-RAS'ta kullanılan projeksiyon sisteminin tanımlanması 

HEC-RAS’ta birim sistemin ve projeksiyon sisteminin tanımlanmasından sonra nihai raster 

verisi: Tools → New Terrain adımları ile programa eklenmiştir. New Terrain Layer penceresi Şekil 

4.8’de ve uygulamada kullanılacak terrain layer Şekil 4.9’da verişmiştir. 
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Şekil 4.8. New Terrain Layer penceresi 

 

Şekil 4.9. HEC-RAS ortamına alınmış Terrain Layer 
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Map Layers katmanı kullanılarak da raster verinin çalışma alanını gösterip göstermediği 

kontrol edilmiş ve Şekil 4.10’da da görüldüğü gibi raster verimizin Yeşildere Barajı ve mansap 

bölgesinde bulunan yerleşim yerini doğru bir şekilde temsil ettiği görülmüştür. 

 

Şekil 4.10. Raster verisi ile çalışma alanının görüntüsü 

HEC-RAS programına ArcGIS’ten aktarılan altlık üzerinde muhtemel taşkın sınırlarında 

bulunan alanlar (2D Flow Areas) tanımlanmıştır. Baraj yıkılması sonucu taşkına maruz kalacağı 

düşünülen alanların sınırları: Geometric Data → 2D Flow Area adımları ile saat yönünün tersin 

doğrultusunda çizilerek oluşturulmuştur. Şekil 4.11’de muhtemel taşkının yayılabilecek sınırı 

görülmektedir. Taşkın alanının ve yönünün daha sağlıklı sonuç verebilmesi için taşkın yayılım alanı 

küçük hücre (5x5 m) ağlarına ayrılarak Şekil 4.12’de gösterilmiştir. Ayrıca baraj göl alanı sınırı 

Geometric Data → Storage Area adımları ile Şekil 4.13’de ki gibi tanımlanmış, Yeşildere barajına 

ait hacim-satıh eğrisi değerleri ve hacim-satıh eğrisi Yeşildere Barajı Planlama Raporundan temin 

edilerek Şekil 4.14 ve Şekil 4.15’te gösterildiği gibi girilmiştir. 
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Şekil 4.11. Tanımlanmış taşkın alanı 

 

Şekil 4.12. İki boyutlu taşkın alanı özellikleri 
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Şekil 4.13. Tanımlanmış göl alanı 

 

Şekil 4.14. Hacim-satıh eğrisi değerleri 
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Şekil 4.15. Yeşildere Barajı Hacim-satıh eğrisi 

Taşkın yayılım alanında meydana gelecek taşkının yönüne göre taşkın sınırını temsil edecek 

olan mansap sınır şartı SA/2D BC Lines butonu ile Şekil 4.16’da görüldüğü gibi belirlenmiştir. 

 

 

Şekil 4.16. Mansap sınır şartı çizgisi 
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HEC-RAS’da SA/2D Connection butonu seçilerek taşkın yayılım alanı ile baraj göl alanı 

arasına bağlantı noktası olarak baraj gövdesi düzenlenmiştir. Baraj gövdesi: Edit Connection → 

Connection Data Editor → Weir/Embankment adımları ile gövde yükseklik ve genişlik bilgileri 

girilmiştir. Baraj yıkılma analizi için gerekli olan parametreler HEC-RAS tarafından kullanılan 

MacDonald et al, Froehlich 1995, Froehlich 2008,  Von Thun & Gillette ve Xu & Zhang yöntemleri 

için ayrı ayrı yapılmıştır. Her bir yıkılma denkleminde kullanılan veri girişleri Şekil 4.17 – Şekil 

4.21’de gösterilmiştir.  

 

 

Şekil 4.17. MacDonald et al yıkılma parametreleri 

 

Şekil 4.18. Froehlich 1995 yıkılma parametreleri 
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Şekil 4.19. Froehlich 2008 yıkılma parametreleri 

 

Şekil 4.20. Von Thun & Gillete yıkılma parametreleri 
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Şekil 4.21. Xo & Zhang yıkılma parametreleri 

Unsteady Flow kabulü ile 5 dakikalık hassasiyetle her bir model için Yeşildere Barajı yıkılma 

parametreleri, pik debi miktarları ve pik debi oluşma süreleri Tablo 4.2’de verilmiştir.  

Tablo 4.2. Yeşildere Barajı yıkılma parametreleri ve hesaplanan pik debiler 

Sıra No Hesap Yöntemi 
Gedik Taban 

Genişliği (m) 

Şev 

Eğimi 

(Y:D) 

Yıkılmanın 

Tamamlanma 

Süresi (saat) 

Pik Debi 

(m3/s) 

Pik Debi 

Oluşma 

Süresi (dk) 

1 MacDonald et al 30 0.5 1.25 5516.63 58 

2 Froehlich 1995 39 0.9 0.63 11564.72 37 

3 Froehlich 2008 37 0.7 0.58 11408.40 35 

4 
Von Thun & 

Gillette 
132 0.5 1.03 8820.22 26 

5 Xu & Zhang  52 0.59 0.99 7096.41 46 

 

Tablo 4.2 incelendiğinde pik debi ortalamasının 8881.27 m3/s ve pik debi oluşma süresinin 

ortalamasının 40.4 dakika olduğu görülmüştür. Şekil 4.22’de yukarıdaki tabloda hesaplanan 

yöntemlere ait yıkılma hidrografları verilmiştir.   
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Şekil 4.22. Çeşitli yöntemlerle hesaplanmış taşkın hidrografları 

HES-RAS programındaki hesap yöntemleriyle hesabı yapılan Yeşildere Barajı yıkılma 

analizlerinde; pik debi ortalamasına yakın olan ve pik debi oluşma süresinin 26 dakika olarak 

hesaplanan Von Thun & Gillette yaklaşımı benimsenmiştir. Buna göre Yeşildere Barajı’nın 

yıkılması durumunda 26. dakikada 8820,22 m3/s pik debinin oluşacağı hesaplanmıştır. 

Baraj yıkılma parametreleri tanımlandıktan sonra mansap sınır akım koşullarının 

belirlenmesi gerekmektedir. Mansap çıkış akım koşullarını tanımlamak için Şekil 4.23’de 

görüldüğü gibi normal depth seçilerek eğimi 0.05 seçilmiştir. Ayrıca Şekil 4.24’de görüldüğü gibi 

initial conditions kısmında da başlangıç değerleri girilerek baraj rezervuarının maksimum olduğu 

ve rezervuara gelen hiçbir akımın olmadığı kabul edilmiştir. 
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Şekil 4.23. Mansap çıkış sınır koşulları 
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Şekil 4.24. Initial Conditions (Başlangıç sınır) değerleri 

HEC-RAS programı ile taşkın senaryosuna ve akım bilgilerine ait değerler girildikten sonra 

Unsteady Flow Analysis aracı ile Şekil 4.25’deki analiz başlama ve bitiş tarihi ve saati, oluşacak 

harita süreleri ve hidrograf hesap aralığı parametreleri seçilmiştir. Analizin süresi 6 saat olarak 

seçilerek taşkın yayılımının nasıl sonuçlanacağı incelenmiştir. 
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Şekil 4.25. Unsteady flow analysis (Kararsız akım analizi) editörü 

HEC-RAS programında yapılacak analizin detay ayarlarını yapmak için Options → 

Calculation Options and Tolerances sekmesiyle detay ayar penceresi açılmıştır. Şekil 4.26’da 

verilen Unsteady Calculation Options and Tolerances editöründe Equation Set kısmında 

hidrodinamik çözümde kullanacağımız denklem seti seçimi yapılmıştır. Yeşildere Barajı yıkılma 

analizinde Difüzyon Dalga Denklemi seti seçilmiştir. 

 

 

Şekil 4.26. Unsteady Calculation Options and Tolerances editöründe  



47 

HEC-RAS programında gerekli bütün ayarlamalar yapıldıktan sonra Compute butonuna 

basarak analize başlanılmış ve Şekil 4.27’deki simülasyon sonuç ekranı ile Yeşildere Barajı yıkılma 

analizi tamamlanmıştır. 

 

 

Şekil 4.27. Simülasyon sonuç ekranı 



5. BULGULAR VE TARTIŞMA 

HEC-RAS programı ile Yeşildere Barajı’nın yıkılma analizi yapılarak olası bir yıkılma 

sonucu oluşacak taşkın yayılım haritası elde edilmiştir. Baraj yıkılması sonucu oluşacak taşkına ait 

10’ar dakikalık risk haritaları Şekil 5.1 – Şekil 5.6’da görülmektedir. Ayrıca Şekil 5.7’de 

maksimum derinlikteki taşkın risk haritası ile Şekil 5.8’de taşkın yayılım hız haritası görülmektedir. 

 

Şekil 5.1. Yeşildere Barajı 10. dakikadaki taşkın risk haritası 

 

Şekil 5.2. Yeşildere Barajı 20. dakikadaki taşkın risk haritası 
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Şekil 5.3. Yeşildere Barajı 30. dakikadaki taşkın risk haritası 

 

Şekil 5.4. Yeşildere Barajı 40. dakikadaki taşkın risk haritası 
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Şekil 5.5. Yeşildere Barajı 50. dakikadaki taşkın risk haritası 

 

Şekil 5.6. Yeşildere Barajı 60. dakikadaki taşkın risk haritası 
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Şekil 5.7. Yeşildere Barajı maksimum taşkın risk haritası 

 

Şekil 5.8. Yeşildere Barajı taşkın yayılım hız haritası 

Yeşildere Barajı yıkılma analizinde saat 00:09’da ortalama 5,0 m yüksekliğindeki taşkın 

dalgaları yerleşim yerine ulaştığı gözlenmiştir. Şekil 5.9.’da yerleşim yerine ulaşan taşkın 

dalgalarının yükseklikleri görülmektedir. 



52 

 

Şekil 5.9. Yerleşim yerine ulaşan taşkın dalgalarının yükseklikleri 

Baraj yıkılma simülasyonunda 00:40’da ortalama 7,0 m yüksekliğindeki taşkın dalgaları 

Bursa – Çanakkale otoyoluna ulaştığı gözlenmiştir. Şekil 5.10.’da otoyola ulaşan taşkın 

dalgalarının yükseklikleri görülmektedir. 

 

Şekil 5.10. Bursa-Çanakkale yoluna ulaşan taşkın dalga yükseklikleri 



6. SONUÇLAR 

Barajlar, rezervuarlarında çok büyük hacimlerde su biriktiren yapılar olduğundan yıkılmaları 

halinde çok büyük felaketlere yol açabilmektedir. Aşırı yağışlara nazaran, baraj yıkılmaları 

sonucunda oluşacak taşkınların büyüklükleri oldukça fazladır. Bundan dolayı baraj mansabında 

yerleşim yerlerinin bulunması ciddi risklerin oluşmasına neden olmaktadır.  

Bu tez çalışmasının amacı; Bursa İli Karacabey İlçesi Yeşildere Mahallesinde inşası devam 

eden Yeşildere Barajı’nın 2 boyutlu yıkılma analizini yaparak, baraj mansabında bulunan yerleşim 

yerinin taşkın riskinin belirlenmesi, haritalarının oluşturulması, taşkın su yüksekliğinin ve taşkın 

oluşma zamanının belirlenmesidir. 

HEC-RAS programı kullanılarak Yeşildere Barajı’nın gövdesinde olası meydana gelebilecek 

yıkılmanın analizi gerçekleştirilmiştir. Baraj yıkılma analizinde kullanılan ArcGIS ve HEC-RAS 

programları çalışmanın Materyal ve Metot bölümünde ayrıntılı olarak anlatılmıştır. 

Yeşildere Baraj planlama raporunda bulunan hacim – satıh değerleri kullanılarak baraj 

rezervuarının tamamen dolu olduğu ve dışarıdan herhangi bir akımın olmadığı kabul edilmiştir. 

HEC-RAS programında baraj yıkılma hesap yöntemleri ile pik debi hesapları yapılarak 

ortalama pik debi değerine daha yakın ve pik debi ulaşma süresinin daha kısa olduğu Von Thun & 

Gillete yöntemi ve taşkın yayılım durumunun daha iyi gözlenmesi için 6 saatlik analiz süresi 

seçilerek simülasyon işlemine başlanılmıştır. 

Yeşildere Barajı yıkılma analizi sonucunda; baraj mansabının 1,0 km uzağında bulunan 

Yeşildere Mahallesine 9 dakika sonra 5,0 m yüksekliğinde taşkın dalgalarının ulaştığı ve yerleşim 

yerinin büyük bir kısmının sular altında kaldığı tespit edilmiştir. Ayrıca oluşan taşkın dalgalarının 

40 dakika sonra ortalama 7,0 m yüksekliğindeki taşkın dalgalarının Bursa-Çanakkale otoyoluna 

ulaştığı tespit edilmiştir. 

Bu tez çalışması sonucunda Yeşildere Barajı’nın yıkılması sonucunda oluşacak taşkın risk 

haritaları oluşturularak, taşkın anındaki maksimum su seviyeleri ile oluşma zamanları 

belirlenmiştir.   

 

 

 

 



ÖNERİLER 

Bu tez çalışması sonucunda ve baraj yıkılma analizleri ile ilgili yapılabilecek çalışmalara 

yönelik aşağıdaki önerileri sıralanabiliriz; 

 Baraj yıkılmaları sonucu oluşacak taşkınların modelleme çalışmalarında, arazi 

yüzeylerini ve suyun hareketini daha doğru yansıtabilmesi için yüksek çözünürlüklü ve 

hassasiyetli sayısal yükseklik haritaları kullanılmalıdır. 

 1 ve 2 boyutlu yapılan baraj yıkılma analizlerinden daha hassas simülasyonlar yapabilen 

3 boyutlu baraj yıkılma analiz programlarının kullanılması çok daha sağlıklı sonuçların 

oluşmasını sağlayacaktır. 

 Bilgisayar programları ile yapılan baraj yıkılma analizlerinin deneysel çalışmalarla da 

karşılaştırılarak bir bütün olarak ele alınmalıdır. 

 Barajlar ve göletler gibi yıkılmaları sonucunda mansap bölgesinde önemli taşkın riski 

oluşturabilecek su yapılarının planlama veya projelendirme aşamasında yıkılma 

analizlerinin de yapılarak taşkın risk haritalarının belirlenmesi gerekmektedir. Özellikle 

mansap bölgesinde yerleşim yerlerinin yada önemli yapıların bulunması durumunda ise 

muhakkak taşkın risk analizleri yapılmalıdır.  

 Geçmişte meydana gelen baraj yıkılmaları incelenerek mevcut bilgisayar programları 

yardımıyla gerçeğe yakın modellemeler oluşturulabilir. Modellemeler sonucunda elde 

edilen çıkarımlar mevcut barajlar ve yapılması planlanan barajlar için altlık olarak 

kullanılabilir. 

 Baraj yıkılmalarının önlenebilmesi ve önceden gerekli tedbirlerin alınabilmesi için 

mevcut ve yapılması planlanan barajlarda ölçüm aletlerine önem verilmesi, 

kalibrasyonlarının titizlikle yapılması ve bu konuda uzman personellerin yetiştirilmesi 

gerekmektedir. 

 Baraj yıkılmaları sonucunda oluşabilecek taşkınlar can ve mal kayıplarına neden 

olabileceğinden taşkın risk haritalarının oluşturulması ve risk haritalarından da 

yararlanarak, erken uyarı sistemleri ile acil afet planlarının oluşturulması gerekmektedir.  
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